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WORD TO THE WISE: Work closely with your dissertation chair AND 
give the same careful attention to the details of the format as you do to the 
content. 

 
 

Guide to Formatting Dissertations 
 

Effective date: Fall 2009 
 

The ELF Guide to Formatting Dissertations provides instructions and 
regulations for style and formatting of dissertations in the Department of 
Educational Leadership and Foundations. This new edition replaces all 
guides and templates previously released by the Graduate School and the 
department.   
 
Simplified rules, samples, and links are also provided.  When in doubt, 
consult your dissertation chair or the Graduate School; do NOT use old 
dissertations, from this or any school, as a template.   
 
In addition to the regulations here, you should also be familiar with other 
aspects of the dissertation process, as described in the Ed.D. Handbook. 
Final responsibility for the format and content of any dissertation remains 
with the student. 

 
Much of the content in this document is adapted from The Guide to 
Preparing Graduate Theses 6th edition published by WCU's Graduate 
School.  
 



ELF Dissertation Formatting Guide 

TABLE OF CONTENTS 
 

 
1.  Preparing the Dissertation ............................................................................1 

1.1 Software Capabilities and Pre-formatting ............................................1 
1.2 Software Tips for MSWord Users ........................................................2 
1.3 Arrangement of Contents......................................................................3 
1.4 Formatting Guidelines ..........................................................................4 

1.4.1 General Rules...............................................................................4 
1.4.2 Section Rules ...............................................................................6 
1.4.3  Pagination ....................................................................................9 
1.4.4  Special Materials........................................................................10 

 
2. Defending and “Printing”............................................................................11 

2.1 Oral Defense and Signatures ..............................................................11 
2.2 Evaluation of Dissertation ..................................................................11 
2.3 Electronic Submission and Binding ...................................................13 

2.3.1 Embedding Fonts and Preparing the Digital Manuscript...........13 
2.3.2 File Conversion..........................................................................14 
2.3.3 Submitting Your Dissertation Online ........................................15 
2.3.4 Approval and Clearance to Graduate .........................................15 

 
APPENDIX A:  Dissertation Check Sheet ..........................................................18 

General Issues Checklist..................................................................................18 
FORMATTING CHECKLIST ........................................................................19 

 
Appendix B: Online Submission Check Sheet ....................................................20 
 
Appendix C: Sample Dissertation Pages .............................................................21 

{SAMPLE APPROVAL PAGE} ....................................................................23 
{SAMPLE TITLE PAGE} ..............................................................................24 
{SAMPLE ACKNOWLEDGEMENTS PAGE}.............................................25 



ELF Dissertation Formatting Guide 

{SAMPLE TABLE OF CONTENTS PAGE} ................................................26 
{SAMPLE LIST OF TABLES PAGE}...........................................................27 
{SAMPLE ABSTRACT PAGE} ....................................................................28 
{SAMPLE BODY PAGE}..............................................................................29 

 
 



ELF Dissertation Formatting Guide 

 1

 
1. Preparing the Dissertation 

 
Read this section BEFORE you begin writing your dissertation. 

 
1.1 Software Capabilities and Pre-formatting 

 
Familiarize yourself with recent versions of Microsoft Office programs, 
especially Word.  While the Graduate School does not endorse or recommend 
any brand of software, most students find it easiest to use these programs.  In 
particular, make sure you understand the following functions: 
  

☺  Tabs and tab “leaders” (especially for the Table of Contents) 
 ☺  Headers and footers 
 ☺  Pagination   
 ☺  Sections and section breaks 
 ☺  Rulers 
 ☺  Show/Hide Characters button (“¶” on the toolbar) 
 
Knowing how to use the functions above will save you hours of work and 
frustration.   
 
Perhaps even more important are the functions you should NOT use.  Unless you 
are extremely proficient with the software, we recommend that you severely limit 
(or turn off) the following tools: 
 
 /  AutoCorrect and AutoFormat 

/ Preformatted headings, themes, or templates 
 
These functions are the primary culprits when you have trouble with numbered 
lists and unwanted changes to headings and titles. 
 
Be aware that although there are software programs to help with references, they 
do not all end up preparing your reference section accurately for APA style. It is 
YOUR responsibility to ensure accurate references in the correct format. 
 
Above all, remember that the final draft of your dissertation must ultimately be 
ONE electronic file.  Multiple files for each chapter are fine for now, but keep 
any formatting as simple as possible so you can combine chapters/files easily 
after you defend.  When you have finished your dissertation, see Appendix A for 
more information. 
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1.2 Software Tips for MSWord Users 
 
Here are a few more tips to help you with file and document management.  See 
sections 1.1 and 2.3 for more information on software. 
 
BEFORE starting a new document: 
 
• Select “Print Layout” under the View tab to see how your document will 

look when printed. 
• Set page margins according to the rules in this guide. 
• The default tab setting in MS Word is ½”. Do not change this setting.  All 

tabs and indentations in your dissertation must be ½”. 
• Keep rulers (found under the View tab) visible at all times. 
• Turn on AutoSave and save your document at regular intervals.  Keep 

backup copies of everything. 
• You may wish to turn OFF the “AutoFormat” function (founder under 

Tools).  This will stop MS Word from automatically changing headings and 
numbering as you type. 

• Do not pre-format or paginate chapters or sections. 
 
DURING the writing of your document: 
 
• For now, save the separate sections of your dissertation (individual chapters, 

etc.) in separate files.  Use distinct file names, including a notation about the 
date or draft number. 

o e.g. Chap1-Intro-vers2.doc  
• Use the tab key (default setting to ½”), NOT the space bar, to indent all 

paragraphs or tab any text. 
• Be familiar with the Show/Hide Characters function (“¶”) on the toolbar. 

This tool toggles on and off, and shows hidden errors in spacing and format. 
• Use Symbols and Special Characters (under the Insert tab) for foreign 

languages, statistical symbols, and special punctuation. 
• Be sure to use embedded fonts (see section 2.3.1) 
 
AFTER writing your document: 
 
• When your dissertation is finished (i.e., a full draft is ready for committee 

review prior to the defense), combine your separate files into one master file.   
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• Prepare your abstract, Table of Contents and other “front matter” according 
to the rules and samples in this guide.  (See Section 1.4:  Formatting 
Guidelines and Appendix C.) 

• Insert a section break between the end of the front matter and the body of 
your dissertation.  This will allow you to put page numbers in the body of the 
text and make sure they continue from the previous section.  (See Section 
1.4:  Formatting Guidelines) 

• Paginate your dissertation last, then complete your Table of Contents.  Be 
sure you have followed all formatting rules before submitting to the Graduate 
School. 

 
1.3 Arrangement of Contents 
 
Your dissertation must include the following sections IN THIS ORDER:   
 

1. Title Page (required; with optional copyright) 

2. Acknowledgements (optional) 

3. Dedication (optional) 

4. Table of Contents (required – page numbers begin after this section –  
see 1.4.3) 

5. List of Tables (required - if tables used) 

6. List of Figures (required - if figures used) 

7. List of Abbreviations or Symbols (if used) 

8. Abstract (required) 

9. Body 

10. References (required) 

11. Appendices (if used) 

 
Information on each of these sections begins with Section 1.4.2. 
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1.4 Formatting Guidelines 
 
In general, writing style and formatting should follow the APA Publication 
Manual (5th edition for dissertations begun prior to January 2010, 6th edition for 
dissertations begun January 2010 or later). In some cases, WCU has specific 
rules that conflict with or supplement APA style. In these cases, follow WCU 
guidelines.   
 
1.4.1 General Rules 

 
Your entire dissertation must conform to these rules: 
 

Margins   Top, Bottom, and Right:  one inch (1”).   
Left:  one and a half inches (1½”).  

 
Font ONLY: 12 pt. Times New Roman or 10 pt. Arial.  All text 

must be the same font and size, including page numbers. 
 
Text Double space body text.  (Exceptions apply for title page, 

Table of Contents, footnotes, and other special text.) Do 
NOT justify the text.  Tabs should be set at ½”.  New 
paragraphs must be indented ½”.  All text must be in black 
ink.  

 
Chapters Each chapter of the dissertation must begin on a new page.  

Do not insert blank sheets between chapters. 
 
Chapter Titles CAPITALIZE and CENTER.  Do not bold or underline 

chapter titles.  Insert at least two blank lines (i.e. triple 
space) between titles and body text. Sub-headings within 
chapters should follow the heading levels described in the 
APA Publication Manual. See sample in Appendix C. 

 
Pagination  Page numbers must appear in the upper right hand corner, 

¾” from the top of the page.  For detailed rules, see 1.4.3: 
Pagination. 

 
Tables/Figures Tables and figures must not exceed margins (see above). All 

tables/figures in the body of the dissertation must be 
formatted and labeled according to APA guidelines, 
although word tables may be single spaced.  Depending on 
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dissertation length and number of tables/figures, numbering 
may be done consecutively through out the dissertation (e.g., 
Figure 1, Figure 2) or consecutively within the chapter (e.g., 
Table 4.2 is the second table in chapter 4). Tables and 
figures should appear within the chapter, near their first 
reference in the text, rather than at the end of the document. 
Triple space between tables and adjacent text. More 
extensive tables/figures should appear in an appendix.  For 
more information, see 1.4.2: Section Rules. If tables or 
figures are not original, you must cite them and comply with 
PROQUEST/UMI’s copyright rules.   
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1.4.2 Section Rules 
 
Individual pages and/or sections of the dissertation must follow the rules below, 
as well as the “General Rules” (1.4.1).  Samples of these sections are provided in 
Appendix C. 
 

Approval Page (required):   
Follow the sample and information in Appendix C. Approval pages may be 
printed on regular copy paper. Take blank approval pages to your defense; 
after a successful defense, have your committee sign in BLACK ink. 
[SPECIAL NOTE: If your dissertation title changes prior to final submission, 
it is your responsibility to make sure your approval page is correct AND that 
you notify the Graduate School if there is a change in title from that you 
submitted on your graduation application.] 
 
Title Page (required):   
Follow the sample in Appendix C. The title should be in all caps and 
centered. Use your full name in the byline. The title page technically counts 
as page “1” of the dissertation, but no number should appear on the page. 
 
Copyright (optional):   
This is optional. Most students choose not to copyright their dissertations, 
though some exceptions apply. Ask your director for advice. If you plan to 
copyright your dissertation, you must include a copyright on the TITLE 
PAGE. 
 
Acknowledgements (optional): 
This page is optional, but most students choose to acknowledge their 
committee and others who assisted with the dissertation. Follow the sample 
in Appendix C, and remember to keep your language formal. 
 
Dedication (optional): 
This page is optional, but some students choose to dedicate their work.  
Follow the same format as the sample acknowledgements page in Appendix 
C. 
 
Table of Contents (required):  
This table is extremely important, and MUST be accurate.  All titles, 
subheadings, and page numbers must correspond exactly to the body of the 
dissertation.  Single space the table.  Use tab leaders between titles and page 
numbers.  For best results, wait until your dissertation is totally completed 
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before writing the Table of Contents.  Follow the sample in Appendix C, and 
see the “General Rules” (1.4.1).   
 
List of Tables (required – if tables used in dissertation): 
“Tables” are tabulated numerical data or word summaries used in the body of 
the dissertation (or appendix). See the APA Publication Manual for a 
description of tables. If you have tables in the body of your dissertation, you 
must create an accurate master list.  For more information on tables, see 
section 1.4.1:  General Rules.  Follow the sample in Appendix C. 
 
List of Figures (required if figures used in dissertation): 
“Figures” are any non-textual materials, such as illustrations, charts, graphs, 
maps, photographs, drawings, diagrams, etc. as defined by the APA 
Publication Manual. If you have figures in the body of your dissertation, you 
must create an accurate master list.  For more information on figures, see the 
“General Rules” (1.4.1).  Follow the sample in Appendix C.   
 
List of Abbreviations/Symbols (optional):   
If you use abbreviations or symbols frequently, you should create a master 
list.  Ask your director whether you need this list. 
 
Abstract (required):   
Consult with your director about how to write the abstract—a short 
(approximately 250 to 500 words) summary of your dissertation.  Follow the 
sample in Appendix C to format your abstract.  You will also have to submit 
this to PROQUEST/UMI (see Section 2.3: Electronic Submission). 
 
Body (required):   
The body of the dissertation must follow the “General Rules” (1.4.1). 
 
References (required): 
Citations must follow the guidelines provided in the APA Publication 
Manual. You are responsible for ensuring correspondence between your 
narrative and the reference list, and the accuracy of your references.  EVERY 
reference in the body of your dissertation must be in your reference list and 
every reference in your list must be one cited in the body of your text. Your 
reference list MUST be in alphabetical order. 
 
Footnotes/Endnotes (optional):  
If used, endnotes and footnotes should be formatted according to the APA 
Publication Manual. For footnotes, both the superscript number within the 
body of the text and its reference must appear on the same page.  
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Appendix (optional): 
Appendices, if used, must follow the same rules as body text. Font may 
deviate from the rules if a figure or exhibit cannot be represented in 12-point 
Times New Roman or 10-point Arial. If there is more than one appendix, 
include a cover page that lists the titles of appendices. If tables or figures are 
used, follow the rules in this guide and the APA manual. Multiple items that 
are related or grouped (e.g., a set of cover letters, a group of supplemental 
tables) may be included in a single appendix.  If you have special materials, 
such as CDs or slides, see “Special Materials.” 

 
If the rules in this guide conflict with APA rules, follow WCU rules. If there is 
no applicable rule in either this guide or APA, follow general APA style.   
 

 
 
 
 
 

The easy-to-use Check Sheet in Appendix A   
will help you follow all the rules in this section. 
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1.4.3  Pagination 
 
Page numbers must appear in the upper right hand corner of all body text, ¾” 
from the top of the page. Use Arabic numerals (1, 2, 3, etc.). 
 
Page numbers do NOT appear on the title page or Table of Contents 
 

START “COUNTNG” WITH THE TITLE PAGE 
 
PAGINATE EVERY PAGE AFTER THE TABLE OF CONTENTS 

 
The first page of your dissertation (the Title Page) is page 1, but no number 
appears. The first page of the body of your dissertation does have a number in the 
top corner. See the sample in Appendix C. 
 
 Counts 

towards 
pagination

Counts 
As Page 
Number 

Print 
Page 

Number 
on 

Page(s) 

What 
shows in 

the 
document 

Example 1     
Approval Page N n/a N  
Title Page Y 1 N  
1-page Table of Contents Y 2 N  
1-page abstract Y 3 Y 3 
First page of body (first 
chapter or intro) 

Y 4 Y 4 

     
Example 2     

Approval Page N n/a N  
Title Page Y 1 N  
2-page Acknowledgements Y 2 & 3 N  
3-page Table of Contents Y 4 - 6 N  
1-page abstract Y 7 Y 7 
First page of body (first 
chapter or intro) 

Y 8 Y 8 

 
Use consecutive Arabic numerals throughout; do not restart numbering at the 
beginning of sections/chapters. Continue pagination through the references and 
any appendices—these count as body text.  
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BEFORE you paginate your dissertation, consult the section on pre-formatting, 
(1.1).  This will help you understand the process better. 
 
 
1.4.4  Special Materials  
 
Photographs: 
 
Photographs/pictures are considered “figures” and should follow the rules for 
figures explained in this section, including labeling. If any pictures are not your 
original material, you must follow PROQUEST/UMI copyright rules 
(www.etdadmin.com/wcu Resources and Guides -> Copyright and your 
dissertation or thesis) for reprinting. 
 

File type:  jpeg is recommended.  .gif and .tif files are also acceptable. 
 

Recordings and Others: 
 

Musical or sound recordings, electronic slideshows, and other special materials 
that are not part of the dissertation document should be uploaded separately when 
the dissertation is submitted to the Graduate School. Any visual/sound file that is 
not original material must follow PROQUEST/UMI  copyright rules 
(www.etdadmin.com/wcu Resources and Guides -> Copyright and your 
dissertation or thesis). 
 

File types: 
Video: mpeg is recommended.  .avi and .mov (Apple) are also acceptable. 
Audio:  wav is recommended. .aif, .midi, and .snd are also acceptable. 

 
Oversized Materials, Slides, and other Special Cases 
 
The use of non-electronic slides or special printouts is not recommended.  If you 
have unusual materials or circumstances that cannot be reproduced electronically, 
consult with your dissertation director. 
 
For more information on how to include media files with the final dissertation 
you submit to the Graduate School visit Proquest/UMI (www.etdadmin.com/wcu 
Resources and Guides -> Including supplementary digital materials). 
   

Do not embed media files in the final PDF version of your dissertation. 
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2. Defending and “Printing” 
 
After you complete your dissertation, you may find the defense and printing 
process stressful.  In order to avoid mistakes and delays, read this entire guide as 
early as possible. Also refer to the EdD Handbook for information about the 
process. 
 
 
2.1 Oral Defense and Signatures 

 
Your director will notify you when you are ready to defend your dissertation, and 
she/he will schedule your defense.  Final dates for oral defense are listed in the 
Ed.D. Handbook. You are STRONGLY advised to schedule well in advance of 
the deadline, since you may need time for an additional meeting if your 
committee requires another meeting. Ask your director for help in preparing for 
your defense.   
 
Before you go to your defense, prepare two copies of a blank Approval Page. 
(You may wish to prepare an extra copy, just in case.)  You are responsible for 
making sure these pages are accurate and correctly formatted. Take your 
approval pages with you to the defense. After your successful defense, your 
dissertation chair will instruct you on having your committee to sign their 
approval.   
 
Send your signed approval sheet to the Graduate School. 
 
Your dissertation director should grade you for your dissertation credit or remove 
“IP” grades after your successful defense.  
 
For more information on your dissertation defense, consult with your director and 
refer to the EdD Handbook. See the following sections for information on what 
to do after you defend. 
 
 
2.2 Evaluation of Dissertation  
 
Once you have defended successfully, your director will advise you about further 
revisions that the committee may require and the process for having those 
changes reviewed and approved. Once your director has given you clearance, 
your final, formatted dissertation must be submitted electronically to the 
Graduate School via ProQuest/UMI at www.etdadmin.com/wcu.   
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You cannot graduate until your final dissertation is approved by the Graduate 
School and is submitted successfully for cataloging and printing. 

 
Do NOT submit your dissertation to the Graduate School until it is finished, 

defended, and formatted according to the rules in this guide. 
 
Format your final dissertation according to the rules in this guide, then check it 
using the Check Sheet in Appendix A.  If you have not hired a copy editor, you 
are advised to have someone read your dissertation who can evaluate it for 
grammatical and/or spelling errors. Also you should have been using SPELL 
CHECK throughout your writing. 
 
No later than the deadline corresponding with your graduation term, submit 
your completed, defended dissertation to PROQUEST/UMI Dissertation 
Publishing (see section 2.3 for details).  
 

Term Submission deadline 
Spring April 10 
Summer July 10 
Fall November 10 

 
Your dissertation will be checked against the rules in this guide. If there are 
errors in your dissertation, you will be asked to correct them and re-submit.  
Time is of the essence in this situation. Best work prior to submission will make 
things easier for you, your chair and the reviewer in the Graduate School. 
 
Make only the corrections requested by the Graduate School. If necessary, you 
may fix any additional minor proofreading errors you notice. Do NOT make 
content changes to your dissertation at this time. If you change your dissertation 
beyond what you are told by the Graduate School, you will have to start the 
checking process all over again. 
 
When your final dissertation is approved as above, the Dean of Graduate School 
and Research will sign your approval pages and you will be cleared to graduate.   
 

See the following section for instructions on completing this process. 
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2.3 Electronic Submission and Binding 
 
In order for your final dissertation to be approved by the Graduate School, you 
must submit a Portable Document Format (PDF) version to the Graduate School 
(via PROQUEST/UMI Dissertation Publishing www.etdadmin.com/wcu). This 
submission must follow all the rules in this guide. In addition, you must purchase 
at least three bound hard copies (one for WCU’s Hunter Library, one for the 
Department of Educational Leadership and Foundations, and one for your 
director). You may also purchase additional copies for yourself, your other 
committee members, and others.  
 
The Graduate School now requires Electronic Theses and Dissertations (ETDs) 
instead of printed copies. Some advantages of ETDs over hard-copy manuscripts 
include: 
  
• Ease of use; 
• Simplified approval and printing processes; 
• Broader exposure for your research; 
• The ability to link directly to your dissertation from your homepage and/or 

electronic CV; 
• Professional development experience as you learn the basic skills of 

scholarly publishing in an electronic format; 
• The option to have your dissertation accessible to any potential reader at any 

time. 
 
After you have prepared and defended your dissertation according to the 
guidelines in this manual, submit your dissertation online as directed below. You 
will have to order your bound copies, which you can order and pay for at the 
same time you submit the dissertation.  
 
2.3.1 Embedding Fonts and Preparing the Digital Manuscript 
 
Make sure all your fonts are embedded fonts (Times New Roman 12 pt or Arial 
10 pt).  Manuscripts without embedded fonts can cause all punctuation and 
formatting to disappear when the document is printed from the digital file, and 
causes delays in the online publishing process. 
 
The manuscript will be submitted as: 
 

• Adobe PDF file  
• NO compression 
• NO password protection 
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For a complete description of preparing the digital manuscript and embedding 
fonts, see www.etdadmin.com Resources and Guidelines. These instructions 
derive from those documents. 
 

To Embed Fonts (in MSWord) 
 

1. On the Tools menu, click Options, and then click the Save tab. 
2. Select the Embed TrueType fonts check box. 
3. Save the document. 

 
Alternatively, if you have Acrobat Professional available to you: 

 
1. Open your document in Microsoft Word 
2. Click on the Adobe PDF tab at top. Select "Change Conversion 

Settings." 
3. Click on Advanced Settings. 
4. Click on the Fonts folder on the left side of the new window. In the lower 

box on the right, delete any fonts that appear in the "Never Embed" box. 
Then click "OK." 

5. If prompted to save these new settings, save them as "Embed all fonts." 
6. The Change Conversion Settings window should show "embed all fonts" 

in the Conversion Settings drop down list and it should be selected. Click 
"OK" again. 

7. Click on the Adobe PDF link at the top again. This time select Convert to 
Adobe PDF. Depending on the size of your document and the speed of 
your computer, this process can take 1-15 minutes. 

8.  After your document is converted, select the "File" tab at the top of the 
page. Then select "Document Properties." 

9. Click on the "Fonts" tab. Carefully check all of your fonts. They should 
all show "(Embedded Subset)" after the font name. 

10. If you see "(Embedded Subset)" after all fonts, you have succeeded. 
 
2.3.2 File Conversion 
 
Read the ProQuest/UMI Formatting Requirements available under Resources and 
Guidelines at www.etdadmin.com/wcu. 
 
Before beginning the submission process, you should combine the text of your 
dissertation into one document and convert it into one PDF file. You have a few 
options here.  Visit Creating PDFs under Resources and Guidelines at 
www.etdadmin.com/wcu. Resources and Guidelines at www.etdadmin.com/wcu 
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offers online conversion of up to five files per registered account, as well as 
extensive information about what you will need to submit your dissertation 
electronically. 
 
If you have access to the required software (a full version of Adobe Acrobat, for 
example) and are familiar with the process, you may convert the file yourself.  
 
 
2.3.3 Submitting Your Dissertation Online  
 
Before you submit your dissertation online to the Graduate School, be sure you 
can answer “Yes” to all these questions: 
 
□ Do you have an abstract of your dissertation to upload? 
□ Have you created a PDF version of your full, defended, and corrected 

dissertation? 
□ Have you properly saved/converted any additional files or special materials 

(see 1.4.4 and 2.3.2)? 
□ Have you consulted PROQUEST/UMI’s copyright rules 

(www.etdadmin.com/wcu Resources and Guidelines) regarding your use of 
pictures, recordings, and long quotations of others’ work? 

□ Have you discussed with your director whether you should copyright your 
dissertation?  Have you discussed the “open” and “traditional” options for 
your published dissertation? (see #6 below) 

□ Have you discussed with your director whether you will need more than 
three bound copy of your dissertation? 

□ Do you have a credit or debit card close at hand? 
 
 
If you answered “Yes” to all of these questions, create a new user account and 
submit your dissertation online: 
 
1. Go to the WCU Graduate School’s website and follow the links to online 

submission, or go to www.etdadmin.com/wcu.   

2. Click Submit My Dissertation/Dissertation.  

3. Click Create an Account and follow the instructions from there. 

4. You will be sent an email to confirm your account. After clicking the link in 
your email, you will be directed back to the PROQUEST/UMI website to 
complete your registration. 

5. Read “Before You Begin” and click Continue at the bottom of the page. 
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6. Choose a Publishing Option and agree to the Publishing Agreement: 

a. Traditional: dissertation sales eligible for royalties but not available 
via the internet – the Graduate School recommends this option 

b. Open Access: no royalties but dissertation available free to all via the 
internet (including search engine access) 

NOTE: The student pays all fees associated with either type. 

7. Fill out all required information and continue to the page where you upload 
your dissertation.  

a. The Details page will require you to upload an abstract 

8. Upload Information:  

a. Before you upload your dissertation, make sure it conforms to the 
rules in this guide. Your entire dissertation must be one PDF 
document.   

b. In some cases, you may have additional files to submit, such as 
concert recordings, slideshows, etc.  You may upload them on the 
“Supplemental Files” page. Do not embed media files (sounds, 
slideshows, etc.) in your dissertation.   

c. Any pictures, recordings, or other materials in your dissertation that 
are not your own originals must follow PROQUEST/UMI’s 
copyright rules. 

d. Permission forms for reprinting copyrighted material must be 
uploaded on the “Supplemental Files” page. 

9. If you wish to copyright your dissertation, you may elect to register it at this 
time. There is a fee for this service. It is not always necessary for doctoral 
students to copyright their dissertations. Talk to your director before you 
decide on “open” and/or “traditional” access and any other publishing issues. 

10. Order Copies 

a. You must send a bound (Hardcover)  8½” x 11” copy of your 
dissertation to Hunter Library.  This copy should automatically be 
listed on the order form. 

b. The department and your director each require an additional copy. 
You may also wish to provide copies to your other committee 
members. Consult your director.  

c. If you wish to order additional copies for yourself or others, do so at 
this time.  



ELF Dissertation Formatting Guide 

 17

11. Review your order and fill in your payment information. Review your entire 
submission, and print or save the page for your records when you are 
finished. 

 
 
2.3.4 Approval and Clearance to Graduate  
 
You will immediately receive an email verifying your submission. The Graduate 
School is also notified via email of your submission.   
 

The Graduate School must approve the dissertation before it can be 
published in the ProQuest/UMI database.  

 
After your dissertation has been reviewed, you will receive an email regarding 
the Graduate School’s approval or denial of your submission. You will be 
notified of any changes that must be made. Consult your director if you need 
clarification about these changes.   
• Log in to your PROQUEST/UMI account  
• Go to “Revise Submission”.   
• Submit your changes as directed.   
 
After all changes and verifications are complete, your dissertation should be 
available online in Western’s database within 8–12 weeks. 
 
If you have additional questions that are not answered here, please visit the 
PROQUEST/UMI site (www.etd.admin/wcu) and visit Support & Training or 
Resources & Guidelines. 
 
Once the final, approved version of your dissertation has been submitted, paid 
for, and approved by the Graduate School, you are clear to graduate (upon 
completion of all other university and programmatic requirements).   
 

• You must apply for graduation for the semester you wish to graduate.   
• You must be enrolled at WCU in the semester in which you graduate. 
• See your program director for details regarding application for 

graduation and continuing enrollment. 
 
One bound copy will be sent directly to Hunter Library. Additional copies will be 
mailed directly to you. It is your responsibility to deliver copies required by other 
people or departments (including the department and your dissertation director). 
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APPENDIX A:  Dissertation Check Sheet 
 
General Issues Checklist 
 
Be sure you answer YES to all the questions below, and follow the Format 
Checklist on the following pages before you submit your final dissertation to the 
Graduate School. 
 

1. Have you successfully defended your dissertation?    
 
□  Yes  □  No 

 
2. Have you read and followed the Graduate School’s Dissertation Guide? 

  
□  Yes  □  No 

 
3.   Has anyone besides you checked this final draft for spelling/grammatical 

errors? 
  

□  Yes  □  No 
 

4. Have you used the citation style specified by the APA Publication Manual? 
 

□  Yes  □  No 
 

5. Have you or a copyeditor checked your references?  
 

□  Yes  □  No 
 

6. In addition to the citation of sources, have you followed the format specified 
in question 4 for all body text, including tables, figures, and headings? 

 
□  Yes  □  No 

 
7. Are all pictures, recordings, and special/additional material your original 

work?  If not, have you followed PROQUEST/UMI copyright guidelines for 
permission to reprint? 

 
□  Yes  □  No 
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FORMATTING CHECKLIST 
 

General Document 
ALL PAGES 

� Margins:  Top, Right, and Bottom = 1”;  
  Left = 1 ½” 
� Font: all text either 10 pt Arial or 12 pt 

Times New Roman. 
� Pagination:   

• Title Page counts as page 1 
• Paginate all pages after the Table of 

Contents 
• Page numbers in upper right corner, ¾” 

from top. 
� Parts included and in the following order: 

1. Title page 
2. Acknowledgements (optional) 
3. Dedication (optional) 
4. Table of Contents 
5. Lists of Tables, Figures, 

Abbreviations/Symbols (if used) 
6. Abstract 
7. Body text 
8. References 
9. Appendices (optional) 

 
 

Title Page 
� Title in all caps 
� Student’s full legal name in byline 
� Director and committee members listed 
� Text matches sample and “General Rules” 

above 
� Copyright included IF DESIRED and paid 

for 
� No page number appears (through to first 

page of body text) 
 

Acknowledgements (optional) 
� Heading centered and all caps, at least 

three spaces between heading and text 
 

Dedication (optional) 
� Heading centered and all caps, at least 

three spaces between heading and text 
 
 

Table of Contents 
� Heading centered and all caps 
� At least triple space between Heading and text 
� Titles of all chapters and subheadings match 

exactly with body 
� Page numbers match exactly with body 
� Single-spaced 
� Headings and subheadings indented 
� Page number references aligned right 
� Tab leaders (periods) used between text and page 

numbers 
� All sections, chapters, and 

subsections/subheadings listed 
 
 

Lists of Tables, Figures, Abbreviations 
� See rules for Table of Contents. All labels in 

body must match front matter lists. 
 
 

Abstract 
� Heading centered and all caps, triple space 

between heading/text 
� Matches sample in Appendix E 
 
 

Body Text 
� New chapters begin on new page, titles centered 

and in all caps 
� Triple space between headings and text 
� Headings follow APA 
� All text double-spaced (except for footnotes, etc.) 
� At least triple space between text & tables/figures 
� Tables/figures labeled and formatted according 

APA and are student’s original work (follow 
PROQUEST/UMI copyright rules). 

 
 

References and Appendices 
� Page numbers, headings, margins follow same 

rules as body text 
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Appendix B: Online Submission Check Sheet 

 
Sections 2.2 and 2.3 outline how to submit your dissertation online.   

 
READ SECTION 2.3 before you submit your dissertation to PROQUEST/UMI 
Dissertation/Dissertation Publishing. Use this checklist to ensure you are ready to 
submit the electronic version of your defended dissertation. 

 
BEFORE submitting online: 

 
� Final, defended dissertation document formatted to WCU rules and 

converted to ONE .pdf file. 
� Supplemental materials (slideshows, recordings, etc.) saved in approved 

file types. 
� PROQUEST/UMI copyright rules observed for any reprinted materials, 

including pictures, quotes, recordings, etc.   
� Abstract prepared 
� Copyright and “open” vs. “traditional” publication discussed with 

director 
� Number of bound copies determined, with help of director 
� Personal funds available to pay for publishing fees, as well as (if needed) 

copyright, extra bound copies, etc. 
� Be sure your document has embedded fonts (see 2.3.1) 

 
Submit Online 
 

Follow detailed instructions in 2.3.3 and 2.3.4 
 
� Create a PROQUEST/UMI account 
� Follow instructions to upload the single pdf of the dissertation (and any 

required supplemental materials such as the abstract, sound files, etc.) 
� Order print copies 
� Provide payment information (for submission, bound copies, and, if 

appropriate, copyright)) 
 

AFTER submitting online: 
 
� Graduate School notification of approval or denial (with required 

changes) 
� Changes submitted as required 
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Appendix C: Sample Dissertation Pages 
 
This appendix contains samples of the major pages in a dissertation.  For 
specific formatting rules, see 1.4.2: Section Rules.  Consult these rules 
first; only use the samples as a guideline.  The list below gives special 
instructions and reminders. 
 
 
Approval Page  Follow the sample and the rules in this 

guide.   
 
Signatures must be in BLACK INK.  Be 
sure to use your FULL name and the 
appropriate terms for your dissertation, 
term, and degree. 
 
NOTE:  Do NOT include this page with 
your electronic dissertation submission.  
Submit in hard copy to the Graduate 
School after you defend. See 2.1: Oral 
Defense and Signatures. 

 
Title Page  Follow the sample and the formatting 

rules in this guide.  Be sure to use your 
FULL name and the appropriate terms 
for your dissertation and degree.   
 
The date should be the month and year 
of your defense. 
 
Be sure to list your director and 
committee members.   
 
Include a copyright only if you have 
discussed this with your director and 
read PROQUEST/UMI’s guidelines 
carefully. 
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Acknowledgements  Optional.  See sample and follow format 
rules in this guide.   
 
Keep your language formal here; avoid 
overly personal statements.  Remember, 
this document will be publicly 
accessible! 

 
Dedication  Optional.  See sample and follow format 

rules in this guide.   
 
Table of Contents See sample and follow format rules in 

this guide.  Be sure to use tab leaders.   
 

This page can be difficult to complete; 
wait until your dissertation is finished 
before making this page. 

 
List of Tables See sample and follow the format rules 

in this guide.  Same rules apply for Lists 
of Figures.  Lists of tables, figures, and 
abbreviations are only necessary if these 
items appear in the dissertation.   

 
Abstract  See sample and follow the format rules 

in this guide.  Date should be the month 
and year of your defense. 

 
 NOTE:  You will also have to submit 

this abstract separately to 
PROQUEST/UMI when you submit 
your dissertation for electronic approval.   

 
Body of Dissertation This sample is meant only as an 

illustration.  Follow the rules in Section 
1.4 to format your dissertation. 
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{SAMPLE APPROVAL PAGE} 
 
 
 

DISSERTATION TITLE HERE 
SINGLE-SPACED IN ALL CAPS 

 
By 

 
John William Doe 

 
A Dissertation 

Submitted to the  
Faculty of the Graduate School 

of 
Western Carolina University 

in Partial Fulfillment of 
the Requirements for the Degree 

of 
Doctor of Education 

 
 
 
 

Committee:  

       Director 

      

      

       Dean of the Graduate School  

Date:        

  Spring 2010 
  Western Carolina University  
  Cullowhee, North Carolina 
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{SAMPLE TITLE PAGE} 
 
 

GENDER THEORY AS MANIFESTED IN THE WORKS OF  
WILLIAM SHAKESPEARE 

 
 

A dissertation presented to the faculty of the Graduate School of  
Western Carolina University in partial fulfillment of the  

requirements for the degree of Doctor of Education. 
 
 

By 
 
 

Jane Ann Doe 
 
 

Director: Dr. Sally Smith 
Associate Professor 

Department of Educational Leadership and Foundations 
 

Committee Members:  
Dr. Herman Glimsher, Educational Leadership and Foundations 

Dr. Alan J. Smithee, Psychology 
 

March 2007 
 
 
 
 
 
 
 

© 2007 by Jane Ann Doe  
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{SAMPLE ACKNOWLEDGEMENTS PAGE} 
 

ACKNOWLEDGEMENTS 
 

 
I would like to thank my committee members and director for 

their assistance and encouragement.  In particular, …. 
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{SAMPLE TABLE OF CONTENTS PAGE} 
 
 

TABLE OF CONTENTS 
 
 
   Page 
List of Tables .............................................................................................  3 
List of Figures ............................................................................................  4 
List of Abbreviations .................................................................................  5 
Abstract ......................................................................................................  6 
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 A Rationale for This Study ..................................................................  9 
 Objectives ............................................................................................ 11 
Literature Reviews ..................................................................................... 12 
 Aflatoxin Literature ............................................................................. 14 
 Chemical Structure ....................................................................... 15 
 Acute Toxicity .............................................................................. 17 
 Chronic Studies ............................................................................. 19 
 Rat Pathology Resulting from Aflatoxin ...................................... 24 
 Cellular Responses to Aflatoxin B1 .............................................. 25 
 Subcellular Responses to Aflatoxin B1 ........................................ 26 
 Additional Problems Caused by Aflatoxin B1 .............................. 34 
 Problems of Aflatoxin Occurrence, Control and  
 Prevention .................................................................................. 36 
 Future Problems Associated with Aflatoxin ................................. 36 
 Estradiol Literature............................................................................... 39 
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Liver Template Activity ............................................................................. 50 
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{SAMPLE LIST OF TABLES PAGE} 
 

LIST OF TABLES 
 
 
Table Page 
 1. Summary of Spectral Data on Aflatoxins ................................. 11 
 2. Susceptibility of Various Species to the Acute Action of  
  Aflatoxin ................................................................................... 13 
 3. Comparative Lethality of Single Doses of Aflatoxin B1 .......... 15 
 4. Weight Gain, Duration, and Tumor Incidence of Rats Fed Diets  
  Containing Casein or Dried Beef and Petroleum Solvent- 
  Extracted Peanut Meal .............................................................. 19 
 5. Weight Gain, Duration, and Tumor Incidence of Rats Fed Diets 
  Containing Dried Beef and/or Methanol-Extracted Peanut  
  Meal .......................................................................................... 20 
 6. Tumors Induced by Estrogens .................................................. 42 
 7. Experimental Schematic ........................................................... 54 
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{SAMPLE ABSTRACT PAGE} 
 

ABSTRACT 
 

 
IMPACT OF NATIONAL BOARD CERTIFICATION ON STUDENT 

ACHIEVEMENT 

 
Amelia Cordelia Bedelia, Ed.D. 
 
Western Carolina University (November 2009) 
 
Director: Dr. John Smith 
 
 
Text of abstract, summarizing the dissertation, here.  Double space text.  

Most abstracts are between 250 and 500 words.  Standard formatting 

rules apply; see the complete dissertation guide.   
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{SAMPLE BODY PAGE} 
  
 
 
 
 
 

 

 
               7 
 

CHAPTER ONE:  BACKGROUND 
 
 

 This is sample body text to show you how a typical 

dissertation page should look.  Margins are not to scale, but 

everything else here follows WCU rules. 

Note the placement of the page number, and that this 

dissertation does NOT start on page “1.”   

 Also note the chapter title is centered and in all caps.  

Body text begins three lines below the chapter title.  Lastly, note the 

body text follows the rules in this guide, including tabs, fonts, etc.  

Use the Graduate School’s guidelines to format the body of your 

dissertation properly. 

  

 - 1.5”- 
Left 

Margin 

 - 1”- 
Right 

Margin 

 - 1”- 
Bottom 
Margin 

Font: Either 12 pt Times 
New Roman or 10 pt Arial; 
all text in same font and size 
– including page numbers 

Chapter Title in all caps, centered, with 
at least two spaces after.  No extra 

spaces required  after 1” top margin 

 - 1”- 
Top 

Margin

Page number in upper 
right - ¾” from top 


